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Informaţii de identificare a disciplinei 

Facultatea: Științe Reale, Economice şi ale Mediului 

Catedra: Matematică și Informatică  

Domeniul general de studiu: 32 Ştiinţe sociale, 33 Asistenţă socială  

Domeniul de formare profesională la ciclul II: ciclul II, studii de masterat, 322 Psihologie, 331 

Asistenţă socială 

Specialităţi: Psihologie judiciară, Politici şi servicii sociale pentru familie şi copil, Consiliere 

psihologică în instituţii şi organizaţii 

Denumirea disciplinei: Informatica aplicată 

Administrarea disciplinei: 

Specialitate 

Codul 

unităţii de 

curs 

Credite 

ECTS 

Total 

ore
 

Repartizarea 

orelor
 

Forma 

de 

evaluare 
 

Limba 

de 

predare Prel. Sem. Lab. l. ind. 

Politici şi servicii 

sociale pentru familie 

şi copil, Consiliere 

psihologică în 

instituţii şi organizaţii 

F.01.O.005 5 150 8 - 32 110 exam rom 

Psihologie judiciară F.01.O.006 5 150 8 - 32 110 exam rom 

 

Statutul: disciplină obligatorie 

Informaţii referitoare la cadrul didactic 

Titularul cursului – Radames Evdochimov, magistru în informatică, lector superior universitar. 

Absolvent al Universităţii de Stat „Alecu Russo” din Bălţi, specialitatea „Matematica şi 

Informatica”. A efectuat studii de masterat la aceeaşi universitatea la specialitatea Informatica de 

gestiune. La fel, a efectuat diferite stagieri în domeniul tehnologiilor informaţionale, inclusiv 

organizate de Alianţa Universitară Francofonă şi Centrul de resurse USB-WETEN. S-a 

specializat în domeniul informaticii, tehnologiilor informaţionale şi comunicaț ionale aplicate.   

Biroul – Catedra de matematică și informatică (aula 145). Tel. 52-4-88. 

E-mail: evdochimov.radames@gmail.com 

Orele de consultaţii - marţi: 14.10 -15.30. Consultaţiile se oferă atât în regim „faţă-în-faţă”, cât şi 

prin utilizarea poştei electronice sau Skype. Numele în Skype – evdochimov.radames. 

Integrarea disciplinei în programul de studii 

Societatea contemporană se dezvoltă în condiţiile creşterii volumului fluxurilor 

informaţionale în toate domeniile activităţii societăţii, ceea ce implică dezvoltarea tehnologiilor 

de colectare, stocare, prelucrare şi transmitere automatizată a informaţiei – tehnologii 

informaţionale. Astfel, apare necesitatea formării la specialiştii din diferite domenii de activitate, 

inclusiv specialiştii psihologi şi sociologi, a unor competenţe trainice de utilizare a tehnologiilor 

informaţionale.  

Studierea disciplinei „Informatica aplicată” se bazează pe cunoştinţele, capacităţile şi 

competenţele dezvoltate în cadrul disciplinei „Tehnologii informaţionale şi comunicaţionale”, 

care se promovează la ciclul I de studii, şi a disciplinei „Metode de calcul statistic în psihologie”, 

care se promovează la anul I la ciclul II de studii. Scopurile şi conţinutul disciplinei au tangenţe 

(legătura indirectă) cu disciplina „Metodologia şi etica cercetării” şi alte discipline din planul de 

învăţământ la ciclul II de studii. 

Disciplina Informatica aplicată are ca scop formarea la specialiştii psihologi şi sociologi a 

unor competenţe specifice de utilizare a tehnologiilor informaţionale în activitatea lor 

profesională pentru prelucrarea automatizată a informaţiei,  analiza datelor, modelarea şi 

rezolvarea diverselor probleme practice, utilizarea tehnologiilor de acces la resursele 

mailto:evdochimov.radames@gmail.com
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informaţionale din reţele locale şi globale, cunoaşterea tendinţelor de dezvoltare a tehnologiilor 

informaţionale moderne şi oportunităţilor aplicării lor în practica psiho-sociologică, capacitatea 

de prezentare a informaţiei într-o formă accesibilă. Anual, conţinutul disciplinei este revăzut şi 

adaptat la noile tendinţe şi realizări în domeniul tehnologiilor informaţionale. 

Disciplina este destinată audienţilor cursurilor de masterat de la specialităţile Psihologie 

judiciară, Politici şi servicii sociale pentru familie şi copil, Consiliere psihologică în instituţii şi 

organizaţii. De asemenea, poate fi utilă şi audienţilor de la alte specialităţi ciclului de master. 

Competenţe prealabile: 

a) Tehnologii informaţionale şi comunicaţionale: Concepte de bază ale tehnologiei 

informaţiei şi sistemului de calcul. Sisteme de operare. Procesarea textelor. Calcul 

tabelar. Prezentări electronice. Reţele de calculatoare şi servicii internet 

b) Metode de calcul statistic în psihologie 

Competenţe dezvoltate în cadrul disciplinei: 

Prin conţinutul său şi activităţile de învăţare a audienților, disciplina „Informatica aplicată” 

contribuie la dezvoltarea mai multor competenţe, necesare specialistului în domeniul ştiinţelor 

psiho-sociologice: 

competenţe profesionale: 

 capacitatea de proiectare; 

 capacitatea de a colecta şi selecta informaţia pentru cercetare, utilizând instrumentele 

reţelei Internet; 

 capacitatea de a prelucra informaţia, utilizând instrumentele unui procesor tabelar; 

 capacitatea de a perfecta într-un editor de texte un document complex (referat, teza de 

master etc.); 

 capacitatea de a prezenta informaţia prelucrată în diverse moduri: prezentări, video 

etc.; 

competenţe transversale: 

 deprinderi de comunicare în limba maternă; 

 capacitatea de a lucra în echipă; 

 capacitatea de a aplica cunoştinţele în practică; 

 capacitatea de a lucra independent. 

 

Finalităţile disciplinei 

La finisarea studierii disciplinei audientul va fi capabil: 

1. Să utilizeze tehnologiile informaţionale moderne cu scopul colectării, stocării, prelucrării, 

transmiterii şi prezentării informaţiei de însemnătate profesională. 

2. Să aplice programele din pachetele birotice (Microsoft Office, Open Office etc.) şi 

aplicaţii birotice de tip cloud on-line (Google Cloud Service), pentru documentarea 

oficiului specialistului (elaborarea de documente, tabele de calcul, prezentări, editoare 

grafice etc.) în domeniul psiho-sociologic, pentru perfectarea tezelor de master şi a altor 

publicaţii. 

3. Să organizeze activitatea profesională on-line prin mijloacele tehnologiilor Web: crearea 

siturilor specializate în bază de şablon şi prin CMS cu diverse servicii: forum, blog, 

album foto, catalogul de articole şi fişiere etc. 

4. Să creeze baze de date şi să le prelucreze prin intermediul instrumentelor de gestionare a 

bazelor de date, de calcul statistic, de analiză clasică şi intelectuală a datelor (Data 

Mining) cu utilizarea aplicaţiilor de calcul tabelar (Excel, Lotus etc.). 

5. Să efectueze activitatea de cercetare în mediul Internet, testări on-line şi activitatea de 

consiliere în reţea, prelucrarea rezultatelor experienţelor. 



5 
 

 

Conţinuturi: 

 Disciplina „Informatica aplicată” este divizată în şapte unităţi de învăţare. 

Nr 

d/o 
Subiectele predate la curs 

Unitatea de învăţare 1. Tehnologii informaţionale şi comunicaţionale. Noţiunea de informaţie – 

2 ore 

1. Istoria dezvoltării reprezentărilor despre tehnologii informaţionale şi comunicaţionale. 

Clasificarea tehnologiilor informaţionale. Domeniile de aplicare a tehnologiilor 

informaţionale în ştiinţele psiho-sociologice. Conexiunea ştiinţelor psiho-sociologice şi a 

informaticii. 

Unitatea de învăţare 2. Conceptul de societate informaţională. Sistemele informaţionale. Locul 

tehnologiilor informaţionale în activitatea specialistului psiho-sociolog – 6 ore 

2. Informatizarea şi etapele ei. Procesele informaţionale. Conceptul de societate 

informaţională. Aplicaţiile desktop de birou. Tehnoredactarea textelor. Aplicaţii de calcul 

tabelar. Aplicaţii de procesare a prezentărilor electronice (MS PowerPoint). Aplicaţii de 

creare/redactare a secvenţelor video (MS MovieMaker), oportunităţile lor. Editarea 

fluxului video. Dreptul informatic. 

3. Tehnologii comunicaţionale. Servicii Internet şi perspectivele dezvoltării lor. Reguli de 

conduită în reţea. Probleme legate cu Internet-ul. Securitatea în Internet. Utilizarea  

Internet-ului în activitatea specialiştilor din domeniul psiho-sociologic. 

4. Google cloud service. Aplicaţiile Google: Calendar, Translate, Maps, Docs etc. Utilizarea 

lor în activitatea specialiştilor din domeniul psiho-sociologiei. Metodologia creării 

siturilor specializate în bază de şablon şi prin CMS (Content Management System). 

 

Nr 

d/o 
Conţinutul lucrărilor de laborator 

Unitatea de învăţare 3. Mijloacele de planificare, de acumulare şi de prelucrare a informaţiei –  

6 ore 

5. 

Accesul la bazele de date electronice: biblioteca digitală a disertaţiilor din Rusia, baze de 

date PsycINFO, PsycARTICLES ale asociaţiei de psihologi americani (APA), bazele de 

date textfull de literatură ştiinţifică (EBSCO, Science Direct, JSTOR, ProQuest). Reţele de 

socializare Mendeley şi LinkedIn. 

6. 

Tehnologii informaţionale pentru obţinerea (culegerea) datelor cu caracter psiho-

sociologic (MainTest) Constructoare de teste şi prelucrarea rezultatelor. Crearea testelor 

online şi atragerea celor cercetaţi prin intermediul rețelelor sociale.  

7. 

Mijloace de planificare şi de prelucrare a informaţiei (time management, mind map, 

Outlook). Organizarea fluxurilor informaţionale cu scopul creşterii eficacităţii lucrului. 

Tehnologia RSS şi Subscribe.  

Unitatea de învăţare 4. Documentarea electronică a oficiului – 4 ore 

8. 

Realizarea documentării electronice a oficiului. Crearea şi utilizarea şabloanelor 

documentelor. Perfectarea documentelor de volum mare. Secţiuni. Numerotarea 

documentelor. 

9. Crearea cuprinsului automat şi a indexului documentului. Link-uri. Note de subsol. 

Crearea şi procesarea tabelelor, a figurilor şi a diagramelor. 

Unitatea de învăţare 5. Metode de prelucrare cantitativă şi statistică a datelor cercetărilor psiho-

sociologice – 6 ore 

10. 
Metode de prelucrare, de analiză şi de calcul a datelor cercetărilor sociologice prin prisma 

bazelor de date (Excel): sortarea datelor, crearea filtrelor, gruparea şi structurarea datelor, 

formarea totalurilor, consolidarea tabelelor, tabele pivot. 
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11. 
Instrumentele de bază de modelare în aplicaţiile de calcul tabelar (Excel): căutarea 

soluţiei, selectarea parametrilor, tabele de căutare (Lookup), manager de scenarii. 

12. Analiza statistică în aplicaţiile de calcul tabelar (Excel). Funcțiile statistice. Crearea şi 

procesarea diagramelor. 

Unitatea de învăţare 6. Prezentarea rezultatelor cercetărilor psiho-sociologice – 2 ore 

13. 

Elaborarea şi procesarea prezentărilor electronice grafice. Aplicaţii de procesare a 

imaginilor, a clipurilor, a sunetului (MovieMaker) şi oportunităţile lor. Editarea fluxului 

video. Încadrarea lor în prezentările electronice. 

Unitatea de învăţare 7. Organizarea lucrului în echipă prin mijloacele tehnologiilor 

informaţionale – 6 ore 

14. 

Servicii cloud service (servicii de nor) utilizarea lor în activitatea specialiştilor din 

domeniul psiho-sociologiei. Înregistrarea pe domenul care oferă servicii cloud (Google). 

Utilizarea aplicaţiilor Google: Calendar, Translate, Maps.  

15. Utilizarea aplicaţiilor Google Docs: Document, Foaia de calcul, Desen, Prezentare, 

Formular. Organizarea propriului spaţiu informaţional profesional. Tehnologii wiki.  

16. 

Crearea siturilor, utilizând instrumente ale pachetelor birotice şi prin CMS (Content 

Management System), utilizând constructoare de situri: Google, 

http://mymoldtelecom.md/, http://www.ucoz.ro/ etc. 

 

Activităţi de lucru individual: 

Recomandările metodice privind efectuarea proiectelor 

și a sarcinilor practice 

Proiectele și sarcinile practice se prezintă profesorului în formă electronică. Ultimul 

proiect trebuie să fie prezentat cel puţin cu două săptămâni înainte de examen.  

Audientul primește sarcini individuale de la cadrul didactic în timpul orelor de laborator. 

Fiecare sarcină contribuie la însușirea tehnologiilor informaționale, utilizate în activitatea 

practică a psiho-sociologului,  de exemplu, căutarea și alcătuirea revizuirii publicațiilor 

științifice noi, consacrate unei probleme psiho-sociologice.  

Efectuarea sarcinilor este necesară pentru însușirea cunoștințelor teoretice obținute și 

formarea competențelor generice și profesionale, menționate anterior, ale masterului socio-

psiholog. 

Fiecare unitate de învățare se finalizează cu o evaluare fie în formă de proiect, fie în formă 

de lucrare practică. 

Proiectul 1. Elaborarea și perfectarea unui referat la tema tezei de master 

În lucrare trebuie să fie prezentată analiza activității sale profesionale pe baza exemplului 

obligațiunilor executate în cadrul serviciului curent sau pregătirii disertației de magistru.  

Fiecare audient elaborează referatul în mod independent, respectând un șir de cerințe către 

perfectarea referatului. 

Structura referatului:  

1. Foaia de titlu;  

2. Cuprins (de creat obligatoriu cuprinsul automat);  

3. Introducere;  

4. Conţinutul referatului (nu mai puţin de două capitole);  

5. Concluzii;  

6. Bibliografie (cel puţin 5 surse). 

În lucrare audientul trebuie să demonstreze:  

a. posedarea - și înțelegerea subiectului în cadrul unității de învățare3;  
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b. capacitatea de a organiza informațiile, de a construi carduri inteligente și alte forme de 

carduri;  

c. capacitatea de a configura parametrii paginii, de a numerota și de a configura 

numerotarea paginilor, de a crea și de a utiliza secțiuni într-un document;  

d. capacitatea de a crea o structură a documentului, în conformitate cu structura 

informațiilor prezentate, de a folosi o varietate de stiluri de formatare, de a crea un sistem 

de link-uri interne ale documentului, de a insera automat un cuprins, de a crea un index; 

e. abilitatea de lucru cu diferite categorii de materiale:  texte, liste, formule, tabele, figuri 

(desene, fotografii, diagrame etc.). 

Forma de reprezentare a raportului: 

Audienții trebuie să prezinte referatul în formă electronică într-un fişier 

referat_nume_prenume.doc cel târziu la sfârșitul săptămânii a cincea. 

Proiectul 2. Situl personal  

Pentru elaborarea sitului personal audienții se înregistrează pe unul din situri care oferă 

posibilitate de construire și de utilizare gratuit a unui sit: Google, http://mymoldtelecom.md/, 

http://www.ucoz.ro/ etc. 

Proiectul constă din două părți: situl de lucru personal în rețeaua Internet, la fel, și 

documentația privind structura sa, destinația și tehnologiile informaționale de bază aplicate 

pentru elaborarea acestuia. Pe parcursul pregătirii documentelor referitoare la elaborarea sitului, 

audientul trebuie să demonstreze:  

1. cunoașterea de concepte și înțelegerea subiectului unităţilor de învăţare 2 și 7 ale acestui;  

2. abilități de analiză și de selecție a tehnologiilor informaționale pentru realizarea de 

activități profesionale;  

3. capacitatea de a organiza informațiile, de a construi carduri inteligente și alte forme de 

carduri;  

4. capacitatea de a crea o structură de documente, în conformitate cu structura de informații 
declarate, de a folosi o varietate de stiluri de formatare, de a crea un sistem intern de 

referințe ale documentului, de a crea un cuprins.  

În timpul pregătirii proiectului se recomandă să răspundeți la următoarele întrebări:  

1. Care este publicul-țintă al sitului/blogului?  

2. Ce mesaj vreau să transmit publicului-țintă?  

3. Cum am atrage publicul-țintă pentru sit?  

4. Modul în care va fi organizat feedback-ul?  

5. Ce amenințări informaționale există pentru situl meu?  

6. Cum pot să-l protejez? 

Fiecare audient își elaborează situl personal, însă la etapa completării și promovării sitului, 

audienții creează o rețea, înregistrându-se la siturile colegilor, comentând diferite articole, poze, 

postări, discutând în forum etc. În așa mod, prima etapă de evaluare se efectuează de către 

colegii din grupă. 

 

Forma de reprezentare a raportului: 

Audienții trebuie să prezinte situl și documentarea sa în formă electronică (adresa sitului) 

și, corespunzător, într-un fişier situl_Nume_Prenume.doc. rezultatele trebuie să fie prezentate cu 

maxim două săptămâni înainte de examen.  

Evaluare 

Cunoştinţele, capacităţile şi competenţele audienților vor fi evaluate: 

 O lucrare de evaluare la prelegeri; 

 În cadrul lecţiilor practice fiecare unitate de învățare se evaluează sau printr-o lucrare de 

evaluare, sau prin proiect (conform calendarului disciplinei); 
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 Prin realizarea sarcinilor de lucru independente, inclusiv a lucrărilor de laborator propuse 

la fiecare unitate de învățare (conform calendarului disciplinei); 

 La examenul final (conform orarului întocmit de decanat). 

Nota finală la disciplina „Informatica aplicată” se calculează conform formulei: 

N_f=0,6xn_i+ 0,4xn_e, 

unde N_f – nota finală; n_i – media notelor pentru sarcinile de lucru independent, lucrări de 

evaluare obligatorii și proiecte, n_e – nota de la examen. 

Examenul final se promovează prin susţinerea unui test electronic care înglobează sarcini 

din întregul curs.  

 

Resurse informaţionale ale disciplinei 

1. Evdochimov Radames, Conceptele de bază ale Tehnologiei Informației și Sistemului de 

Calcul, Note de curs (pentru specialitățile neinformatice), Presa universitară bălțeană, Bălți, 
2011, 73 p. 

2. Popov Lidia, Olaru Ion, Tehnologii Informaţionale, Modulul Procesorul de texte Microsoft 

Word 2007, Ghid metodic, Presa universitară bălţeană, Bălţi, 2014, 287 p. 

3. Ghid de Utilizare Microsoft Office 2007, Versiunea documentului 2.0, 2008, 135 p. 

[Электронный ресурс] http://ebookbrowsee.net/ghid-de-utilizare-microsoft-office-2007-

pdf-d162755730  

4. Уэйн Л. Винстон, Microsoft Office Excel 2007 Анализ данных и бизнес-моделирование, 

Пер. с англ., Москва, Издательско-торговый дом "Русская Редакция", СПб, БХВ – 

Петербург, 2008, 608 с. 

5. Наследов А.Д., Тарасов С.Г., Применение математических методов в психологии, СПб, 

2002. 

6. Паклин Н.Б., Орешков В.И., Бизнес-аналитика: от данных к знаниям, СПб: Изд. Питер, 

2009, 624 с. [Электронный ресурс] http://padabum.com/d.php?id=52105 

7. Сапегин А.Г., Психологический анализ в среде Excel. Математические методы и 

инструментальные средства, Москва, Ось-89, 2005, 144 с. [Электронный ресурс] 

http://knigi.tor1.ws/index.php?id=359813 

8. Зарубежные сетевые социальные сервисы WEB 2.0 в проектной деятельности 

[Электронный ресурс]. http://www.permwiki.ru/ Зарубежные-сетевые-социальные-

сервисы-WEB-2-0-в-проектнои-деятельности.ashx. 

9. Социальные сетевые сервисы [Электронный ресурс]. http://ru.wikipedia.org/wiki/ 

Социальные_сетевые_сервисы. 

10. Cloud computing [Электронный ресурс]. http://ro.wikipedia.org/wiki/ Cloud_computing 

 

 

Modele de itemi 

pentru evaluarea finală la disciplina „Informatica aplicată”, ciclul II, masterat,  

specialitatea „Psihologie judiciară, Politici şi servicii sociale pentru familie şi copil,  

Consiliere psihologică în instituţii şi organizaţii” 
 

1. Din lista studenţilor e necesar de selectat acei studenţi care învaţă la facultatea de 

psihologie şi asistenţă socială. Pentru aceasta se efectuează operaţia de 

 1. centralizare a datelor 

 2. grupare a datelor 

 3. filtrare a datelor 

 4. sortare a datelor 
 

2. Pentru a calcula numărul de studenţi pentru fiecare facultate aparte se utilizează 

operaţiile de 
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 1. sortare după câmpul facultăţi şi grupare 

 2. filtrare 

 3. sortare după câmpul facultăţi şi centralizare 

 4. sortare după câmpul facultăţi şi creare a subtotalurilor 
 

3. Din lista de mai jos selectaţi elementele diagramei 

 1. titlul diagramei 

 2. legenda 

 3. foaia de calcul 

 4. etichetele datelor 

 5. celula 

 6. tabelul cu date 
 

4. Pentru a modifica tipul diagramei utilizăm 

 1. Insert->Charts 

 2. Chart Tools->Design 

 3. Change Chart Type din meniul contextual al diagramei 

 4. Chart Tools->Format 
 

5. Se dă desenul A cu tabel, ce operaţii trebuie efectuate asupra acestui tabel astfel încât să 

obţinem tabelul din desenul B? 

 1. Sortare în ordine crescătoare după Nr d/o 

 2. Sortare în ordine crescătoare după Denumirea produsului 

 3. Sortare în ordine descrescătoare după Denumirea produsului şi filtrare numai a 

produselor care se măsoară în kilograme 

 4. Filtrarea numai a produselor care se măsoară în kilograme 

 5. Sortare în ordine crescătoare după Denumirea produsului şi filtrare numai a produselor 

care se măsoară în kilograme 

 6. Filtrarea produselor cu preţul unităţii >=25 

 7. Filtrarea preţului unităţii de produs >=25 şi sortarea în ordinea crescătoare după 

Denumirea produsului 
 

6. Funcţia care întoarce numărul de celule cu numere din diapazonul de celule indicat 

 1. COUNT 

 2. NUMBER 

 3. CALCULATE 

 4. COUNTA 
 

7. Care din serviciile Internet permit accesarea calculatorului în reţea pentru a-i folosi 

resurse tehnice în scopul prelucrării informaţiei. 

 1. Telnet 

 2. FTP 

 3. Usenet 

 4. Chat 
 

8. Fişiere care conţin informaţia în limbajul HTML se numesc 

 1. pagini Web 

 2. site 

 3. host 

 4. text document 
 

9. Care din topologii de reţele nu pot fi utilizate fără dispozitiv server? 

 1. Star 

 2. Bus 
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 3. Ring 

 4. mixtă 
 

10. Dreptul de utilizare a unei aplicaţii software poartă numele de 

 1. patent 

 2. ISP 

 3. licenţă 

 4. verificare 
 

11. Printre serviciile oferite de Internet nu se regăseşte 

 1. E-mail 

 2. Chat 

 3. FTP 

 4. HTML 
 

12. Calculatoarele care oferă resurse pentru utilizatorii reţelei se numesc 

 1. server-e 

 2. clienţi 

 3. microcalculatoare 

 4. partajator 

 5. master 
 

13. Mijloace antivirus reprezintă un produs soft şi/sau un dispozitiv care îndeplineşte una 

sau câteva din următoarele funcţii: 

 1. crearea viruşilor 

 2. depistarea viruşilor 

 3. multiplicarea viruşilor depistaţi 

 4. răspândirea viruşilor 

 5. neutralizarea viruşilor 
 

14. Selectaţi avantajele programelor-proprietate cu licenţa cu plată 

 1. mai uşor de utilizat pentru nespecialişti, mai ales în format consolă 

 2. costul mult mai redus, gratuit sau foarte ieftin, chiar dacă se iau în calcul cheltuielile 

conexe 

 3. asistenţa tehnică asigurată de către un furnizor mare şi cunoscut 

 4. costuri reduse de întreţinere (actualizare, devirusare, reparare bug-uri) 

 5. poate fi uşor îmbunătăţit şi adaptat 
 

15. Programul oferit de Google care permite editarea textelor se numeşte 

 1. Document 

 2. Foaie de calcul 

 3. Prezentare 

 4. Formular 

 5. Desen 
 

16. Selectaţi meniul care se utilizează pentru oferirea dreptului anumit de acces la 

documentul curent 

 1. Fişier 

 2. Editare 

 3. Vizualizare 

 4. Instrumente 
 

17. Aplicaţia Google care permite determinarea căii de călătorie se numeşte 

 1. Google Maps 

 2. Google Translate 
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 3. Google Calendar 

 4. Google Search 
 

18. Un document Google poate fi descărcat în formatul .jpg 

 1. Da 

 2. Nu 
 

19. În programul Desen se cere ştergerea unei laturi ale formei dreptunghi, cum va fi 

realizată operaţia 

 1. prin Editare->Anulaţi 

 2. prin Editare->Decupaţi 

 3. prin Editare->Stergeţi 

 4. este imposibil 
 

20. Pentru modificarea formatului unei figuri în programul Desen e necesar 

 1. să indicăm criterii de formatare şi să desenăm figura 

 2. să desenăm figura şi să-i indicăm criteriile de formatare 

 3. nici un răspuns nu este corect 
 

21. Asupra unei foi de calcul în Google pot să lucreze mai mulţi utilizatori simultan 

 1. Da 

 2. Nu 
 

22. Pentru a utiliza serviciile Google în plină funcţionalitate utilizatorul trebuie 

 1. să acceseze situl Google şi să lanseze serviciul necesar 

 2. să acceseze situl Google, să logheze şi să lanseze serviciul necesar 

 3. să acceseze situl Google, să activeze meniul Gmail sau Disc şi să lanseze serviciul 

necesar 
 

23. Pentru a modifica numărul, ordinea şi tipul conţinutului secţiunilor unui sit ucoz se 

utilizează 

 1. Constructor 

 2. Catalog 

 3. Panoul de control 
 

24. Pentru a adăuga orice informaţie pe sit e necesar 

 1. să intre pe sit 

 2. să logheze pe sit ca administrator 

 3. să activeze regimul Constructor 

 4. să logheze pe sit 
 

25. Pentru a putea găsi informaţia plasată pe situl personal cu ajutorul instrumentelor de 

căutare oferite de Internet, intrările respective trebuie 

 1. să conţină tag-uri 

 2. să conţină link-uri 

 3. să afle în secţiunea Căutare 

 4. să conţină text 
 

26. Discutarea sincronă a unui subiect concret pe internet se realizează cu ajutorul 

 1. Chat-ului 

 2. Forum-ului 

 3. Blog-ului 
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Principiile de lucru în cadrul disciplinei 

1. O parte din sarcinile de învăţare vor fi propuse pentru realizare în grupe mici prin cooperare. Deşi 

activitatea de învăţare va fi una colectivă, notele pentru realizarea sarcinilor vor fi individuale. 

Prezentarea sarcinilor realizate va fi însoţită de o evaluare reciprocă a membrilor subgrupului pentru a 

identifica aportul fiecărui membru în rezultatul final. 

2. Este salutată poziţia activă a audientului, care studiază din propria iniţiativă noi conţinuturi, propune 

soluţii (aplicaţii, instrumente Web), formulează întrebări în cadrul prelegerilor şi a orelor practice. 

3. În cadrul disciplinei o atenţie sporită va fi oferită respectării principiilor etice. Prezentarea unor soluţii 

a sarcinilor, preluate de la colegi sau din alte surse, preluarea informaţiilor din diverse surse, fără a 

face trimitere la sursă, va fi considerată plagiat şi va fi sancţionată prin note de „1”.  

4. Audienții care lipsesc la ore motivat sau nemotivat sunt obligați să efectueze toate lucrările de 

laborator, să susțină toate testele de evaluare curentă și să realizeze proiectele propuse. În cazul dacă 

audientul nu acumulează numărul total de note la curs, el nu este admis la forma finală de evaluare.  
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Note 

 


